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3.1 Performance Objectives and Assessment Instruments 
 

Instructional Goal Instructional Goal with Performance Objective Added 

 
GKLS authors, who are required to convert legacy 
FrameMaker documentation to the new Xerox branding, will 
use Paragraph Tools and FrameMaker to independently 
create officially branded documentation from legacy 
documentation that will pass Xerox branding requirements. 

 
When working on a project requiring the conversion of legacy content 
to the new Xerox branding (CN), GKLS authors will successfully 
demonstrate the skills required to independently and successfully 
create officially branded documentation (B) that will pass Xerox 
branding requirements (CR). 

Terminal Objective with Learning Context Added 

 
During the training, GKLS authors, who are required to convert legacy 
FrameMaker documentation to the new Xerox branding (CN), will 
successfully demonstrate the use of Paragraph Tools and 
FrameMaker to independently create officially branded 
documentation from legacy documentation (B) that will pass Xerox 
branding requirements (CR). 

 
 

Main Step in Instructional Goal Performance Objective for Main Step 

1.0  
Set up for conversion: Ensure all 
needed files, software, and the Xerox 
branding policy are ready. 

Given the supplied Getting 
Started checklist, participants 
indicate that they have all the 
items required to begin the 
conversion process. 

Participants check items on the Getting Started checklist 
that are present or complete. All items must be checked to 
proceed. Items not checked must be resolved before 
proceeding. 
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Subordinate skills 
Performance 
objectives for 

Subordinate skills 

Parallel Test 
Items 

Directions 

1.1  
Get latest branded 
template and Branding 
policy 

Given the Xerox 
website address, 
download the latest 
version of the Xerox 
Global FrameMaker 
template and Xerox 
Branding policy. 

Why is it 
important to use 
the latest Xerox 
Global template 
and Xerox 
Branding policy 
when rebranding 
documents? 

See 1.1.1, 1.1.2, and 1.1.3 below. 

 1.1.1  
Go to 
Brand.com 

Given the website 
address, open the 
Brand.com website. 

Why does the 
Brand.com 
website exist? 
What is its 
purpose? 

a. Open a web browser. 
b. Go to http://xww.brandcom.world.xerox.com/ 
 

 1.1.2 
Download 
latest 
version of 
Xerox 
Branding 
policy 

Locate and 
download the Brand 
Identity System 
document from the 
Brand.com website. 

For rebranding 
purposes, why is 
it important to be 
familiar with the 
Brand Identity 
System? 

a. Locate and download the latest version of the Brand 
Identity System from the Specification Manuals section of the 
Brand.com website. 
b. If you have an existing version, check the version number 
on the top left corner of the template. Use the template that is 
newer. 

 1.1.3 
Download 
latest 
version of 
Xerox 
Global 
Template 

Given the website 
address, go to the 
DocuShare site 
where the latest 
version of the Xerox 
Global FrameMaker 
template 

Explain why is it 
important to have 
the latest version 
of the Xerox 
Global template? 

a. Open a web browser. 
b. Go to 
http://xww.docushare.world.xerox.com/dsweb/View/Collection-
747538 and locate, download, and unzip the latest version of 
the  Xerox Global FrameMaker Template 
 

http://xww.brandcom.world.xerox.com/
http://xww.docushare.world.xerox.com/dsweb/View/Collection-747538
http://xww.docushare.world.xerox.com/dsweb/View/Collection-747538
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Subordinate skills 
Performance 
objectives for 

Subordinate skills 

Parallel Test 
Items 

Directions 

1.2  
Examine Branding 
policy for updates 

Given the latest 
Xerox Branding 
policy, identify 
changes to the 
policy that might 
affect your 
conversion. 

Suppose that you 
have already 
rebranded a 
document. 
Explain why 
would you bother 
to revisit the 
Branding policy? 

a. Open the Brand Identity System document and note, in 
chapters 6 and 7, any updates.  
b. Go to the matching sections on the Brand.com website 
(Color Palette and Typography) for any “late breaking” 
changes. 

1.3  
Check FrameMaker 

Identify the 
FrameMaker 
software version; 
identify the Xerox 
Sans font and 
Paragraph Tool add-
ins as per item 1.3 
in the Getting 
Started checklist. 

Suppose that one 
of the items on 
the checklist were 
not checked. Give 
reasons why the 
rebranding 
process should 
not continue. 

a. See 1.3.1, 1.3.2, and 1.1.3 below. 

 1.3.1  
Open 
FrameMaker 

Identify the installed 
version of 
FrameMaker. 

Which version of 
FrameMaker is 
installed? 
Why is it 
important to know 
which version of 
FrameMaker you 
are using? 

a. Open Framemaker and click Help > About FrameMaker. 
b. Write the version number on the Getting Started checklist in 
1.3.1. 
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Subordinate skills 
Performance 
objectives for 

Subordinate skills 

Parallel Test 
Items 

Directions 

 1.3.2  
Check for 
Xerox Sans 
font 

Given the location of 
the Fonts item in the 
Windows Control 
Panel, identify that 
Xerox Sans font, 
which is required, is 
installed. If not 
installed, install the 
font. 

If the Xerox Sans 
font is not listed, 
where can you get 
and how can you 
install the font? 
How many 
variations of the 
Xerox Sans font 
are listed? (12)  
Why are there 
these variations 
instead just a 
single font?  

a. Examine the font list (found by opening the Control Panel 
and then the Fonts item)) for the presence of Xerox Sans. 
b. If Xerox Sans is not available, retrieve and install the font 
and restart the computer and then FrameMaker. Directions for 
where to get the files is printed on the Getting Started check 
list in 1.3.2.  
 
(Each of the 12 font variations has a specific purpose. For 
example, when the font is over 16 points, Xerox Sans Light 
must be used which is one of the variations.) 

 1.3.3  
Ensure 
Paragraph 
Tools is 
installed 

Given that 
FrameMaker is 
open, validate the 
installation and 
version of 
Paragraph Tools. if 
not installed, 
installed the add-in. 

Why must 
Paragraph Tools 
be installed? Why 
is it important to 
know which 
version of 
Paragraph Tools 
you are using? 

a. Use Step 1.3.3 in the Getting Started checklist for 
instructions on how validate the installation and version of 
Paragraph Tools. 

1.4  
Open legacy source file 
and indentify if the file is 
in Structured or 
Unstructured 
FrameMaker and if 
sidehead icons are 
present. 

Given a legacy 
source file, identify if 
the file was written 
using Structured or 
Unstructured 
FrameMaker and if it 
has sidehead icons. 

Think about the 
Xerox Branding 
standards. Why 
must sidehead 
icons be removed 
before rebranding 
begins? 

a. Set FrameMaker to Unstructured (File > Preferences > 
General > Product Interface > Unstructured). 
b. Open the legacy source file.  
c. If the Structured Document window appears: 
     i. Set the FrameMaker to Structured (File > Preferences > 
        General > Product Interface > Structured). 
    ii. Open the legacy source file.  
   iii. From the menu, click XTools > Remove Sidehead   
       Icons 
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3.2 Instructional Strategies 
 

Clusters Instructional Goal Steps  Time required 

1 

Goal Step 1: Set up for conversion 
Objectives: 

 If all the Getting 
Started Check List 
requirements are 
met, as little as 10 
minutes is required. 
If requirements are 
not met, this 
objective can take up 
to 1 hour to 
complete. 

1 
1.1 
1.1.1 
1.1.2 
1.1.3 

1.2 
1.3 
1.3.1 
1.3.2 
1.3.3 
1.4 

       

2 
(Omitted for 

this 
assignment) 

Goal Steps 2.0 to 8: Perform conversion 
Objectives: 

 

2 
2.1 
2.2 
2.2.2 
2.2.2 
2.2.3 

3 
3.1 
3.2 
3.3 
3.4 
3.5 
3.6 

4 
4.1 
4.1.1 
4.1.2 
4.1.3 
4.1.4 

5 
5.1 
5.1.1 
5.1.2 
5.1.3 
5.1.3.1 
5.1.3.2 
5.1.3.3 
5.1.3.4 
5.2 
5.2.1 
5.2.2 
5.2.2.1 
5.2.2.2 
5.2.3 
5.2.3.1 
5.2.3.2 
5.2.4 
5.2.4.1 
5.2.4.2 

6 
6.1 
6.2 
6.2.1 
6.2.2 
6.2.3 
6.3 
6.3.1 
6.3.2 
6.4 
6.4.1 
6.4.2 
6.5 
6.6 
6.7 
6.7.1 
6.7.2 
6.7.3 
6.8 
6.8.1 
6.8.2 
 

6.9 
6.9.1 
6.9.2 
6.10 
6.11 
6.11.1 
6.11.2 
6.11.3 
6.11.4 
6.11.5 
6.12 
6.12.1 
6.12.2 
6.13 
6.14 
6.14.1 
6.14.2 
6.14.3 
6.14.4 
6.15 
6.15.1 
6.16 

6.17 
6.18 
6.18.1 
6.18.2 
6.18.3 
6.18.4 
6.19 
6.19.1 
6.19.2 
6.20 

7.1 
7.1.1 
7.1.2 
7.1.3 
7.1.4 
7.2 
7.2.1 
7.2.2 
7.2.2.1 

8 
8.1 
8.1.1 
8.1.2 
8.1.3 
8.1.4 
8.2 
8.2.1 
8.2.2 
8.2.3 
8.2.4 
8.2.5 

1 hour 
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3 
Terminal objective: During the training, GKLS authors will successfully demonstrate the use 
of Paragraph Tools and FrameMaker to independently create officially branded documentation 
from legacy documentation that will pass Xerox branding requirements. 

 

 
 

Pre-Instructional Activities 

 
Motivation: Participant attention will be gained with an introduction of the material and how completing this training will help them 
decrease the amount of time required to properly convert a document by up to 90%.  
 
Objectives: An agenda and the objectives for the training will be presented to the participant at the beginning of the training. 
Students will be reminded of the section objectives at the start of a section and as a summary at the end of a section. 
 
Student Grouping and Media Selections: The participants for this course will consist of single individuals working independently 
through the training. Media will be a PowerPoint presentation (or BrainShark), printed materials, and the participant’s own computer 
with software. Students will print the Getting Started and Document Evaluation checklists before training starts. 
 

 

Assessment 

 
Pretest: There is no pretest for entry behaviors. The participants who will be converting documentation to the new branding have the 
entry behavior skills and are considered expert FrameMaker users.  
 
Practice Tests: There are no practice tests. Participants will be actually using a file they need to convert as they work through the 
training using check lists to monitor their progress and as criteria for successful progress. 
 
Posttest: There is no posttest. The participant will evaluate the rebranded document against a check list. If it does not meet all the 
check list criteria, the rebranded document is submitted to Xerox Branding for approval before being released. 
 
Student Grouping and Media Selections: Participants will be grouped individually, in their place of work using their own computers 
and software. Media will be a PowerPoint presentation (or BrainShark), printed materials, and the participant’s own computer with 
software. Since they are working through the training to accomplish the goal of completing a rebranding project, this hands-on 
learning approach will satisfy their learning preferences. 
 

 

Comment [HMG1]: Highly motivating  
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Follow-through Activities 

 
Memory Aid: The Brand Identity System document, Getting Started and Document Evaluation checklists, along with written 
instructions on how to perform the conversion will be used as a memory aid for students. These memory aids will also help users to 
begin to feel confident in their newly acquired skills. 
 
Transfer: Hands-on practice will be used to facilitate transfer of skills. 
 
Student Grouping and Media Selections: After training, students will be using these skills on an individual basis. Students will 
have access to the online or printed version of the Brand Identity System document, the Getting Started and Document Evaluation 
checklists, and written instructions on how to perform the conversion. Students will have access to a Wiki where FAQs are available 
as well as telephone and e-mail access to other GKLS authors who are experienced with the conversion process to assist them with 
issues. 
 

 

Content Presentation and Student Participation 
 
Performance Objectives Subordinate to Main Step 1 – Set up for Conversion 
 
Objective 1.1 (includes 1.1.1, 1.1.2, and 1.1.3)  
Get latest branded template and Branding policy 
 
Content Presentation 
 
Content: Students will read about the Xerox Global Template and the new Xerox Branding policy and then acquire them from 
Brand.com and DocuShare. The content will be written in a question/answer format that will simulate questions they might have 
surrounding the branding process. 
 
Examples:  

 Branding – why new? 

 What affect does the new branding have on our documents? 

 What is the Xerox Global Template? 

 How do I locate and download the Xerox Brand Identity System document? 

 How do I locate and download the Xerox Global Template? 
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Student Groupings and Media Selections:  Students will be working independently at their own computer, using their own 
software. Media will consist of a PowerPoint (or BrainShark) presentation to show the examples on their computer. Students will 
download and print a hard copy of the presentation after the course is completed.  
 
Student Participation 

 
Practice Items and Activities: Students will read this section of the presentation on their computer, download the required files, and 
check the appropriate boxes on the Getting Started checklist once this section is completed. 
 
Feedback: Correct execution of this objective will result in the students having copies of the needed documentation and files which 
allows them to proceed. 
 
Student Groupings and Media Selections: Students will be working independently at their own computer, using their own software. 
Media will consist of a PowerPoint (or BrainShark) presentation to show the examples on their computer. Students will download and 
print a hard copy of the presentation after the course is completed. 
 
Objective 1.2 
Examine Branding Policy for Changes 
 
Content Presentation 
 
Content: Students will be instructed to  read chapters 6 and 7 in the Xerox Brand Identity System document and the two matching 
sections of the Brand.com website (Color Palette and Typography) looking for any “late breaking” changes as well as important 
points that are noted. 
 
Examples:  

 How do branding policy changes affect a rebranding project? 

 Chapter 6 – Color Palette 
o What are the acceptable brand colors? 
o Why is it important to use only these colors? 
o Can color palettes be mixed in the same document? 

 Chapter 7 – Typography 
o What is the primary font to be used?  
o What are the acceptable font sizes? 

 

Comment [HMG2]: Since this is the same for all 
objectives, just include it once. 



TCO 665 – Assignment 3 – Peer Review – Page 9 
Brian Laing – April 9, 2009 

Student Groupings and Media Selections:  Students will be working independently at their own computer, using their own 
software. Media will consist of a PowerPoint (or BrainShark) presentation to show the examples on their computer. Students will 
download and print a hard copy of the presentation after the course is completed.  
 
Student Participation 

 
Practice Items and Activities: Students will read this section of the presentation on their computer and check the appropriate boxes 
on the Getting Started checklist once this section is completed. 
 
Feedback: None 
 
Student Groupings and Media Selections: Students will be working independently at their own computer, using their own software. 
Media will consist of a PowerPoint (or BrainShark) presentation to show the examples on their computer.  
 
Objective 1.3 (includes 3.1.1, 3.1.2, and 3.1.3)  
Check FrameMaker 
 
Content Presentation 
 
Content: Students will read this section of the presentation and check FrameMaker for version information, if Paragraph Tools is 
installed, and if Xerox Sans font is installed.  
 
Examples:  

 Start FrameMaker and check the version – why is it important to know which version is installed? (Affects which version of 
Paragraph Tools is needed if it is not already installed). 

 Using the Getting Started checklist, use step 1.3.2 to check for Xerox Sans. Why are there 12 variations of the font? (Each 
variation is for a specific purpose. For example, Xerox Sans Light is for text that is 16 points or larger). 

 Using the Getting Started checklist, use step 1.3.3 to validate that Paragraph Tools is installed and the version that is 
installed. 

 
Student Groupings and Media Selections:  Students will be working independently at their own computer, using their own 
software. Media will consist of a PowerPoint (or BrainShark) presentation to show the examples on their computer. Students will 
download and print a hard copy of the presentation after the course is complete.  
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Student Participation 

 
Practice Items and Activities: Students will read this section of the presentation on their computer, use sections 1.3.2 and 1.3.3 in 
the Getting Started checklist to check Xerox Sans and Paragraph Tools, and check the appropriate boxes on the Getting Started 
checklist once this section is completed. 
 
Feedback: Correct execution of this objective will result in the students having the correct font and FrameMaker add-in installed, 
which allows them to proceed with the training. The presentation will show them the correct location and installation of the font and 
add-in so they can validate that their setup is correct. 
 
Student Groupings and Media Selections: Students will be working independently at their own computer, using their own software. 
Media will consist of a PowerPoint (or BrainShark) presentation to show the examples on their computer.  
 
Objective 1.4  
Open legacy source file and indentify if the file is in Structured or Unstructured FrameMaker 
 
Content Presentation 
 
Content: Students will read this section of the presentation to be able to identify if their source file is Structured or Unstructured 
FrameMaker. If Structured Framemaker, they will move any sidehead icons, if present. 
Examples:  

 Set FrameMaker to use the Unstructured interface 

 Open the legacy source file.  
o How can you tell if it is a Structured FrameMaker document? (Error message appears) 
o How can you tell if a Structured file has sidehead icons? 
o Think about the Branding guidelines. Why should sidehead icons be removed (No sidehead icons allowed in the new 

branding) 
o How can you remove sidehead icons? 

 
Student Groupings and Media Selections:  Students will be working independently at their own computer, using their own 
software. Media will consist of a PowerPoint (or BrainShark) presentation to show the examples of this section on their computer by 
illustrating the differences between a Structured and Unstructured FrameMaker file and what sidehead icons look like.  
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Student Participation 

 
Practice Items and Activities: Students will read this section of the presentation on their computer, check their FrameMaker source 
file and take appropriate actions to remove sidehead icons if present. They will check box 1.4 on the Getting Started checklist once 
this section is completed. 
 
Feedback: Correct execution of this objective will result in the students having a FrameMaker file that can be used with Paragraph 
Tools, which allows them to proceed with the training. The presentation will show The learners how to differentiate between a 
Structured and Unstructured file and how to properly remove sidehead icons if present.  
 
Student Groupings and Media Selections: Students will be working independently at their own computer, using their own software. 
Media will consist of a PowerPoint (or BrainShark) presentation to show the examples on their computer. 
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3.3 Delivery System and Media Selections 
 
Media Selections and Choice of Delivery 
 

Session Objectives 
Type(s) of 
learning 

Media Selections and  
Student Groupings 

Delivery System(s) Time Required 

1 1 

Intellectual 
skills 
(discrimination, 
applying rules) 

Self-paced individual 
instruction with either 
PowerPoint (or 
BrainShark) computer 
presentation. 

Online, self-paced PowerPoint 
(or BrainShark) presentation 
accompanied by self-printed job 
aids and check lists. 

If all the Getting Started 
Check List requirements 
are met, as little as 10 
minutes.  
If requirements are not 
met, this objective can 
take up to 1 hour to 
complete. 

2 
2, 3, 4, 5, 

6, 7, 8 

Intellectual 
skills 
(discrimination, 
applying rules, 
problem 
solving 

Self-paced individual 
instruction with either 
PowerPoint (or 
BrainShark) computer 
presentation. 

Online, self-paced PowerPoint 
(or BrainShark) presentation 
accompanied by self-printed job 
aids and check lists. 

1.0 hour 

 
Delivery System for Instruction and Rational 
All instruction will be delivered through computer-based materials on a participant’s own computer. Since this training is “internal-to-
Xerox”, it will either be housed on the Xerox DocuShare site where the latest branded templates reside as downloadable elements 
(PowerPoint and Word/PDF documents) or via a BrainShark presentation with downloadable elements (the BrainShark uses the 
PowerPoint to create an online presentation).  
 
Corporate Restraints 
This training adheres to Xerox corporate guidelines and, as a result, there are no restraints on the training. Participants will obtain the 
training materials and proceed with them as needed. The training also falls in line with cost-reduction measures at Xerox where travel 
must be approved by the President or CEO of Xerox or a Senior Vice President, and online meetings and training sessions are now 
mandated where participants do not reside in the same city. 
 
Rationale for Instructional Delivery System and Media Selection 
Through discussions with Xerox managers and GKLS staff, it was agreed upon that the individualized approach where participants 
take the training in their own workspace was both practical and economical (no travel and utilizing already-existing infrastructure). 
Additionally, since participants will use the training on an “as needed” basis, retention of what they are learning will be higher since 
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they will have to complete and understand the training in order to correctly rebrand a document that will pass the Xerox Branding 
department’s examination. 

 


